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1. Introduction 

This manual is for users who have purchased an Eltek GenII system 
comprising Eltek standard transmitters, standard repeater(s) and an RC250 
receiver together with the RxConfig or software. 
It assumes that the application is satisfied using this standard equipment and 
that a survey has been conducted to ensure that the radio range covers the 
site in question within the required margin of safety of performance. 
It assumes that the RxConfig software will be used to configure the RC250 
and transmitters and that the RepConf software will be used to set up 
repeaters if required. 
 
Quick survey methodology is included. 
 
Eltek has made all user instructions, manuals, data sheets and technical notes 
available on their website at www.eltekdataloggers.co.uk/support.html. 
Details of specific links are provided where applicable and any relevant 
information is also reprinted in this manual to assist the user.  
 
A section is included for standard accessories, identifications and use. A 
limited number of standard readily available probes and sensors are covered.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
07-06-16  
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2. System principles of operation 

2.1 Appropriate applications 

The Eltek GenII wireless telemetry system is ideal for a wide variety of 
applications that involve the accurate monitoring of data in conditions where 
events are slow moving. 
Therefore, the system works well in applications such as measuring the 
environment in a building or following a process. However, the system cannot 
accurately record values that change very quickly. (<500mS) 

2.2 Transmitter interval 

The GenII system is a one way telemetry system. There is no need for a 
receiving or polling device at the transmitter unit, meaning battery endurance 
can be several years using off the shelf batteries. 
Transmitters send the sensor value(s) or averaged (transmitter dependant) 
sensor values at a random point in time within the configurable transmitter 

interval.  
The receiver is continuously active. The random transmissions from the various 
transmitters are held in a pending value register that is successively updated 
as newer, valid transmissions are received.  
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3. RC250 Receiver 

3.1 Packed items 

• RC250 receiver with serial and Modbus output (RS232) 

• Antenna (basic whip) – Eltek type UHFFlexi/SMA  
• MP12U power supply with regional adaptor 

• LC68 – RC250 to PC serial lead 
• USB to serial converter lead  

• LCTX3 – Transmitter to PC serial lead 
• RxConfig software 
• Optional RS485 adapter (must be ordered with RC250 – see 

accessories.) 

3.2 RxConfig software 

RxConfig can also be downloaded from: www.eltekdataloggers.co.uk 
When installed, RxConfig creates a folder “Eltek”. In this folder are the RC250 
documents for details of Modbus over serial, etc. for Modbus limitations. 
The program allows the user to:-  

• Read transmitter settings 
• Set the transmitter interval 

• Associate an RC250 Channel with a specific transmitter channel 
• Meter configured RC250 channels 

3.3 Operation 

The  RC250 works by first receiving a data 'packet' from a transmitter, verifying 
it, then storing it to be read by the external device or PC. It is verified by means 
of a checksum contained in the message and the associated transmitter 
number.  
If the RC250 does not receive a message from a transmitter within a 
configured time, the stored value will be set to “no data”. For more detail see 
“No Data interval” on page 8 (Section 11). 
Example application: Typically data from the RC250 to the PC is updated every 
30 minutes, so the transmitter interval is set to 5 minutes (that this PC update 
period ÷ 6) and the “No Data” interval to 2 hours. (that is PC update period x 
4). If the transmitter stops transmitting for any reason the PC should register 
this fact after 2 hours. 

3.4 Power Requirements 

The RC250 requires permanent AC mains connection. Use only the AC power 
supply type MP12U provided. Built-in Ni-Mh batteries provide up to 3 days 
standby in the event of power failure. A fully discharged battery is charged in 



 7 

72 hours. Once the batteries become low the RC250 will switch itself into a 
low power mode and turn off the receiver. OFF will appear in the display. 
Note: the RC250 is despatched in the OFF mode. 
The RC250 will power up (turn on) next time external power is applied. The 
display will then switch to working mode. The RC250 can be turned off by 
removing the external power and then clicking Tools >Turn Receiver Off or 
briefly pressing the concealed switch accessed through the case rear. 

3.5 Application 

For users who wish to use the Eltek GenII series of transmitters with third 
party or proprietary software. The RC250 can also be used to interface GenII 
transmitters to: 

• Existing data acquisition systems such as the Datataker DT80 (using 
Modbus) 

• BMS (e.g. Trend) via a Synapsis interface or Trend IQ3 (using Modbus) 

3.6 LED Indicator  

A red LED on the top of the RC250 Indicates the receiver has successfully 
received a valid data packet. (In addition to this, the RC250 display will show 
the serial number of the transmitter received and the RSSI will show the signal 
strength.) 

3.7 RC250 programming leads 

LC68 – used to program the RC250 from the PC serial port or via the USB 
adaptor if no serial port is available 
LCTX3 – used to program the Transmitter from the PC serial port or via the 
USB adaptor if no serial port is available 
A single serial port on the PC can be used but this will mean having to change 
over the LCTX3 lead and LC68 as required. Note, in File > Properties the PC 
com port can be nominated. You can use the Device Manager in Windows to 
list the COM ports available on your computer. Type Device Manager in the 
Windows search box to open this, and look for Ports. USB to serial converters 
supplied by Eltek are listed as Prolific USB-to-serial. 
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3.8 Top panel connections 

12V DC
regulated

comms

12VDC
(inner is -ve)

Comms
(6 way mini Din)  

3.9 Specification 

Maximum no. Channels 160 
AC supply 100 to 250V AC (Use only Eltek power supply type 

MP12U)  
DC input 12VDC Maximum current <150mA 
Battery endurance Up to 72 hours 
Battery charge time Trickle - allow 72 hours to fully charge an 

exhausted battery. 
Controls Concealed button (power off) 
Freq. UHF (Europe) Default is 434.225Mhz (the label on the base will 

give the exact frequency) 
Rx sensitivity -117dbm (typical) 
Antenna connection SMA socket 
Antenna – standard 
type (supplied) 

¼ wave whip (shipped with product) – Eltek 
UHFFlexi/SMA 

Antenna – lightweight 
dipole (optional)  

Indoor/outdoor dipole, lead length 5m standard 
accessory type LW-ANT/SMA. The maximum 
recommended lead length is 10m.  

Antenna – compact 
Yagi (optional) 

Lightweight 3 element Yagi, providing up to 6db 
gain supplied with 5m lead and plug. 

Temperature Range -10 to +55ºC 
Humidity 95% non condensing 
Environment Indoor use only IP40. A secondary enclosure must 

be used for outdoor use 
Transmitter types All in GenII range from serial number 7000 
Transmitter Interval 1 second to 4 hours 
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4. Care and disposal of product 

Care  

Please treat all components with care.  
Do not expose the transmitter to any harsh environment where extremes of 
temperature, humidity or dust can be experienced. 
The transmitter must not be used in any hazardous rated environment. 
Do not disassemble the transmitter for any other reason than configuration or 
battery replacement. Some transmitter types do have a replaceable fuse 
should the battery be reverse connected. 
Do not expose the transmitter to water, rain or spillage. It is not waterproof. 
For operation in these environments a secondary water/weatherproof 
enclosure is required and can be supplied by Eltek  
Do not abuse the transmitter by dropping, knocking or violent shaking.  
Rough handling could damage the transmitter. 
Do not operate the transmitter close to a receiving device – ensure there is a 
separation of 20cm. 
The transmitter power output is below the directive for devices used in a 
medical or hospital environment. For further details contact Eltek. 
 

Disposing of the product 

This electronic product is subject to the EU directive 2002/96/EC for Waste 
Electrical and Electronic Equipment (WEEE). As such it must not be disposed 
at a municipal waste collection point. Please refer to your local regulations for 
direction on how to dispose of this product in an environmentally responsible 
manner 
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5. Maintenance and calibration 

5.1 Maintenance 

There is no specific maintenance or adjustment required other inspection of 
the battery compartment to ensure no corrosion due to battery leakage is 
present and battery replacement when necessary. 
 

Batteries 

Most transmitters are supplied with a pack of 4 or 6 low cost AA LR6 primary 
cells – that is non rechargeable. These should be replaced when the LCD 
battery gauge (if fitted) is flashing. The battery voltage can be interrogated 
using  RxConfig software but is not available on the ModBus output. Failure 
to replace exhausted cells can lead to leakage and corrosion which can 
damage the transmitter circuity and enclosure. 
Always replace with high quality LR6 batteries e.g. GP®Super. It is good 
practice to replace the battery cassette or holder, this is available at low cost 
from Eltek direct or an authorised distributor. 
 
Mandatory battery change at the time of calibration can be cost effective. 
 
The battery chemistry for devices that are AC powered with built in back-up 
batteries (e.g. RX250AL, GD47, GW47 and RP250GD) is NiMh and should be 
reliable for many years. It is suggested that they are replaced after 5 years. 
 

5.2 Calibration  

Calibration of your wireless telemetric system is essential to maintain accurate 
and reliable readings. We recommend annual on-site calibration of RH, 
temperature, Lux, and UV. Equipment can be returned to an accredited Eltek 
distributor or direct to Eltek for transmitters with built in CO2 sensors. 
 
Transmitters that include RH and temperature are best calibrated using the 
sensor exchange procedure. Calibrated digital RH and temp sensors are plug-
in. The original sensor should then be disposed of responsibly or returned to 
UK for safe disposal. Alternatively Eltek can test the returned sensor and issue 
a report for your audit purposes. This service is chargeable. 
 
Transmitters with Lux or Lux and UV sensors are digital devices and can be 
checked against a known light source and calibrated meter. Alternatively they 
can be returned to Eltek for calibration. There is a charge for this service. 
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6. Note about RF performance 

6.1.1 Improving Reception 

Radio waves travel best in open unobstructed spaces. Aerials work best high 
up in open spaces. Unfortunately, it is rarely possible to have both of these 
criteria met! However these two statements should be kept in mind when 
installing the radio system. This will lead to the best performance of the 
system that can be obtained in a given situation. Note that metal objects, 
thick and damp walls significantly attenuate radio signals. Reinforced concrete 
is a real signal killer as it can act like a metal screen.  
If a nearby source of interference contains frequency components in the band 
of the system, then the receiver will be desensitised. This is especially true if 
the interference is stronger than the signal from a distant transmitter. Typical 
sources of interference are mobile phones, walkie-talkie type radios, Tetra 
police communication systems, computer equipment (especially older 
equipment) and anything with a radio transmitter in it, e.g. the components 
of a wireless security system.  
  

6.1.2 Locating the Transmitters 

Try to place the transmitter as high up as possible, but not too close to 
ceilings. Keep away from damp or metal clad walls, metal objects, cabling, 
pipes, etc. Also bear in mind that the fewer obstacles in the path to the 
receiver will give the greater range and reliability of the system. 
 

6.1.3 Locating the RC250 

The RC250 is a single unit that acts as a data receiver. Locate the RC250 
central to the transmitters and clear of sources of radio interference.  
Where range is not a problem the built in antenna supplied should be used 
and provides a very compact installation. Range can be very significantly 
improved using the optional LW-ANT/sma dipole or UHFFlexi/Mag/SMA 
antenna. This should be mounted as high as possible and away from sources 
of interference. 
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7. Accessories 

7.1 Probes and sensors 

Eltek RH and T detachable probe with 
3m lead. (For longer lead refer to Eltek) 

RHT10E 

Leak sensing cable with 15m inactive 
section and 4m active section (other 
combinations POA) for GC60F 

LC-Leak15/4 

7.2 Antenna 

Lightweight indoor/outdoor dipole antenna with 5m 
lead, SMA plug and mounting hardware 

LW-ANT/SMA 

5m coaxial antenna extension lead SMA to SMA ANT-EXT/SMA5m 

¼ antenna on magnetic base with 1.8m lead UHFFlexi/Mag/SMA 

7.3 Wall bracket 

Tamper-resistant wall bracket for all GenII product (except 
TMET) 

WBG 

7.4 Leads 

Serial to USB convertor lead RS232/USB 

2M LC68 lead extender  RS232/2M 

7.5 Connectors 

Mini thermocouple connector type T (brown) MiniT 

Mini thermocouple connector type K (green) MiniK 

7.6 Weatherproof enclosure 

Rugged outdoor (IP65) enclosure with built-in cradle for 
most transmitter types. specify transmitter type and accessories 
required with order - if in doubt contact Eltek 

OD1 series 

7.7 AC Transducer 

AC100/240 transducer - provides an isolated contact closure when 
powered. Detects presence of an AC supply (can be used to assert 
alarms). Use with GD24 or GD34 

EL-CC 

7.8 Power supply 

100-250VAC to 12VDC 7.2W power supply. Specify mains 
plug type with order (UK/Euro/US) 

MP12U 
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100-250VAC to 9VDC  approx.10W supply. Specify mains 
plug type with order (UK/Euro) 

MP9U 

DIN rail mounting AC to 12VDC power supply for GD90A DRA18-12 

Wire-in 24/12V to 9V regulator 24REG9 

7.9 Communications module 

RS485 interface (for RC250 units after serial no. 25194) SQ/RS485 

 
"Wired socket" is the mini Phoenix with cage screw terminals or equivalent 
with strain relief 
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8. Replacement accessories 

8.1 Antenna 
 

Stubby antenna for transmitters 434.225Mhz L=66mm UHFStub/SMA 

Flexi antenna for receiver, repeater or transmitters 
434.225Mhz L= 165mm 

UHFFlexi/SMA 

Flexi antenna on magnetic base with 2M lead with sma 
connector 

UHFFlexi/Mag/SMA 

8.2 Battery 

Battery carrier (4 x AA cells not included) BATCARR4 

Battery carrier (6 x AA cells not included) BATCARR6 

Plug-in rechargeable 7.2V MiMh pack for RP250GD, 
RC250 or GD47 

EL7.2NIMH 

6 x 1.8Ah batteries for RC250, RC250D or WSR EL6XMIMH 

8.3 Connectors 

2 way transmitter connector - screw down - green with 
strain relief 

MINIPL2 

4 way transmitter connector - screw down - green with 
strain relief  

MINIPL4 

5 way transmitter connector - screw down - green MINIPL5 

6 way  transmitter connector - screw down - green MINIPL6 

8 way  transmitter connector - screw down - green MINIPL8 

TiniQG - for GD11 temperature probe QGMX-1320 

8.4 Leads 

TX set up from PC lead  LCTX3 

Receiver to PC serial lead (1.0m) or replacement lead 
assembly for MoxaD-311 

LC68 

 

8.5 TMET 

IP65 outdoor enclosure with pole mount bracket for use 
with TMET only 

WBT 

Pole mounting bracket  Skye or Kipp and Zonen 
 pyranometers 

PyrBkt 
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8.6 Power supply 

AC to 12VDC power supply (For GD40A) MP12U/GD40A 
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9. Supported third party sensor products 

Type Manufacturer Product name Eltek Product 

AC current 
transducer (AC 
output) 

Northern 
Design 

SCL / SCT  GD90A, 
GD900A, 651 
Squirrel 

AC current 
transducer (DC 
output) 

Northern 
Design 

SXD GD40A  

Energy meter Northern 
Design 

NDRail310, 
NDRail350  

GD90A, 
GD900A, 651 
Squirrel 

Energy monitor with 
pulse output 

Rayleigh PRO1D  GC62, GD67 
and GD68  

Energy monitor with 
pulse output 

Rayleigh PRO75D  GC62, GD67 
and GD68  

Energy monitor with 
pulse output 

Elster A100C  GC62, GD67 
and GD68  

Heat meter Landis & Gyr T230  GD93A  

Heat meter Sontex SuperCal 539  GC62, GD67 
and GD68  

Heat meter Sontex SuperStatic 440  GC62, GD67 
and GD68  

Heat flux sensor Hukseflux HFP01  GS44H, 451L 
Sunshine 
pyranometer 

Kipp and Zonen CMP3  GS41Acf, TMET 

Sunshine 
pyranometer 

Skye 
Instruments 

SKS 1110  GS41Acf, TMET 

Water flow meter Flownetix Flownetix 315  GC62, GD67 
and GD68  

Water flow meter Flownetix Flownetix 325  GC62, GD67 
and GD68  

Air velocity E plus E EE576/EE660 GS41AV 

Carbon dioxide 
sensor (0-5/10/20%) 

Vaisala GMT221  GD43E  

Weather sensor Vaisala WXT520  TMET Weather  

Wind sensor Vaisala WMT52  TMET Weather  

People counter 
   

 
 

http://www.ndmeter.co.uk/retro-fit-metering
http://www.eltekdataloggers.co.uk/transmitters/electricity_energy_monitoring.html
http://www.eltekdataloggers.co.uk/transmitters/electricity_energy_monitoring.html
http://www.eltekdataloggers.co.uk/energy_series.html
http://www.eltekdataloggers.co.uk/energy_series.html
http://www.ndmeter.co.uk/current-transducers
http://www.eltekdataloggers.co.uk/transmitters/energy_monitoring_ct.html
http://www.ndmeter.co.uk/rail-mount-metering
http://www.ndmeter.co.uk/rail-mount-metering
http://www.eltekdataloggers.co.uk/transmitters/electricity_energy_monitoring.html
http://www.eltekdataloggers.co.uk/transmitters/electricity_energy_monitoring.html
http://www.eltekdataloggers.co.uk/energy_series.html
http://www.eltekdataloggers.co.uk/energy_series.html
http://www.rayleigh.co.uk/product_details.cfm?ID=RD1065
http://www.eltekdataloggers.co.uk/transmitters/pulse_and_state.html
http://www.eltekdataloggers.co.uk/transmitters/pulse_and_state.html
http://www.rayleigh.co.uk/product_details.cfm?ID=RD1060
http://www.eltekdataloggers.co.uk/transmitters/pulse_and_state.html
http://www.eltekdataloggers.co.uk/transmitters/pulse_and_state.html
http://www.elstermetering.co.uk/en/2068.html
http://www.eltekdataloggers.co.uk/transmitters/pulse_and_state.html
http://www.eltekdataloggers.co.uk/transmitters/pulse_and_state.html
http://www.landisgyr.com/product/landisgyr-ultraheatae-ultracoldae-t230/
http://www.eltekdataloggers.co.uk/transmitters/mbus_connectivity.html
http://www.sontex.ch/supercal739_e.html
http://www.eltekdataloggers.co.uk/transmitters/pulse_and_state.html
http://www.eltekdataloggers.co.uk/transmitters/pulse_and_state.html
http://www.sontex.ch/superstatic_e.html
http://www.eltekdataloggers.co.uk/transmitters/pulse_and_state.html
http://www.eltekdataloggers.co.uk/transmitters/pulse_and_state.html
http://www.hukseflux.com/product/hfp01?referrer=/product_group/heat-flux-sensors
http://www.eltekdataloggers.co.uk/transmitters/heat_flux.html
http://www.eltekdataloggers.co.uk/450_series.html
http://www.kippzonen.com/Product/11/CMP-3-Pyranometer
http://www.eltekdataloggers.co.uk/transmitters/solar_radiance.html
http://www.eltekdataloggers.co.uk/transmitters/weather.html
http://www.skyeinstruments.com/products/minimet-weather-station/sensors/pyranometers-solar-radiation/
http://www.eltekdataloggers.co.uk/transmitters/solar_radiance.html
http://www.eltekdataloggers.co.uk/transmitters/weather.html
http://www.flownetix.co.uk/products/315
http://www.eltekdataloggers.co.uk/transmitters/pulse_and_state.html
http://www.eltekdataloggers.co.uk/transmitters/pulse_and_state.html
http://www.flownetix.co.uk/products/325
http://www.eltekdataloggers.co.uk/transmitters/pulse_and_state.html
http://www.eltekdataloggers.co.uk/transmitters/pulse_and_state.html
http://www.epluse.com/en/products/air-velocity-instrumentation/transmitters-for-air-velocity-measurement/ee576/
http://www.eltekdataloggers.co.uk/transmitters/air_velocity.html
http://www.vaisala.com/en/products/carbondioxide/Pages/gmt220.aspx
http://www.eltekdataloggers.co.uk/transmitters/voltage_current_rh_and_temp.html
http://www.vaisala.com/en/products/multiweathersensors/Pages/WXT520.aspx
http://www.eltekdataloggers.co.uk/transmitters/weather.html
http://www.vaisala.com/en/products/windsensors/Pages/WMT52.aspx
http://www.eltekdataloggers.co.uk/transmitters/weather.html
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10. Repeater notes 

The RP250GD repeater is a self-contained mains operated data packet (GenII 
protocol only) repeater.  
The RP250GDS repeater additionally includes a built-in switchable loudspeaker 
for survey applications. 
 
RP250GD Repeater features: 

• An LCD to view activity and status of transmitters in operation 

• Received Signal Strength Indication (RSSi)  of incoming transmitter data 
(chevron bar) 

 
Using the RepConf, Repeater Configuration software you can: 

• Authorise transmitters you want to be repeated 

• Compensate for systems requiring multiple repeaters 
• Conduct a radio survey 

10.1 Power requirements 

The repeater requires permanent AC mains connection. Use only the AC 
power supply provided. When powered the red LED on the top of the unit will 
flash. Built-in Ni-Mh batteries provide up to 3 days standby in the event of 
power failure. A fully discharged battery is normally charged in 72 hours. 

• When you first receive the RP250GD the display will read OFF 

• The display will switch to working mode when the MP12U power supply 
is connected or by activating the concealed switch if the batteries are 
suitably charged. 

• If you remove the MP12U power supply the unit will stay in working 
mode until the internal rechargeable batteries are exhausted. The display 

will then read OFF. 
 
The repeater can be turned off by removing the MP12U power supply and 
activating the concealed switch under the small hole on the back of the unit 
using an unfurled paper clip or narrow screwdriver. The red LED will stop 

flashing and the display will read OFF. 

10.2 Product Specification 

AC supply:  100 to 250V AC (Use only Eltek power supply type 
MP12U) 

DC input:  12.5VDC Maximum current <70mA 
Battery endurance:   typically 72 hours 



 18 

Freq. UHF (Europe):  default is 434.225Mhz (other frequencies available – 
refer to Eltek) 

Freq. US:  default is 914.5Mhz (other frequencies available – 
refer to Eltek) 

Rx sensitivity:   -117dbm (one chevron on signal strength bar) 
Tx RF power:  10mW 
Antenna connection:   SMA socket 
Antenna - standard:   ¼ wave whip (shipped with product)   
Antenna - alternative:   Indoor/outdoor dipole, lead length 5M standard, 

accessory from Eltek Ltd type LW-ANT/sma. The 
maximum recommended lead length is 10M. 

Transmitter spec:    to European spec EN300-200 
Temperature Range:  -10 to +55ºC 
Humidity:  95% non-condensing 
Environment:  Indoor use only IP40. A secondary enclosure must be 

used for outdoor use 
Backup batteries type: Ni MH pack 

Backup battery life: Typically 24 to 48 hours dependant on activity 

Dimensions: D 41mm x W 80mm x H 125mm 

Weight: 500g inc. batteries 

Receiver/Transmitter: Crystal controlled 

 

Connectors 

DC supply:  2.1mm concentric jack (male) 
Comms (serial):  
3.5mm stereo jack (applicable up to serial number 8480) – use with lead type 
LCTX3 
  
6 pin mini din (applicable to serial number 8481 to current) – use with lead 
type LC68 
 
For the latest detailed RP250GD information see the document TU1007 – 
RP250GD user instructions (available online). 
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10.2.1 Basic system where there is one RP250GD only 

Do not repeat transmitters unnecessarily! 

RC250

Repeater #1
Delay = 0Tx 1002

Tx 1001

 

10.2.2 A system where are there are two or more RP250GD 

Do not repeat transmitters unnecessarily! 

Repeater #1
Delay = 0

Tx 1002

Tx 1001

Repeater #2
Delay = 0

RC250
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10.2.3 For a system where multiple (tandem and radial pattern) 

RP250GD used:  

Do not repeat transmitters unnecessarily! 

Tx 1001

Tx 1002*

Tx 1003

Tx 1004

Repeater #2
Delay = 0

Repeater #3
Delay = 1

Repeater #1
Delay = 0

RC250

 
 

• Tip: Make a proposed system schematic as this will assist set up for 
the various repeaters in the system. 

• *TX1002 could be roving (mobile) around an area of coverage e.g 
monitoring a pallet on a fork lift truck, such that Repeater 2 or 
Repeater 3 would repeat its transmission.  
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10.3 RSSI indicator (calibrated from serial number 7925 to 

current) 

The 16 chevrons indicate the following Received Signal Strength Indication: 
-1

1
6

 -1
0
9

-1
0
6

 -1
0
2

 -1
0
0

 -9
7

 -9
4

 -9
1

 -8
8

 -8
7

 -8
4

 -8
2

-7
9

-7
7

-7
3 dbm

At Risk Marginal Ideal (essential during survey)

-1
1
8

 
 
At Risk: Insufficient margin of safety to guarantee year-on-year  

performance  
 
Marginal: Depending on environmental factors, performance may be inhibited 

or inconsistent. 
 
Ideal: Signal should be ideal at all times. (Recommended for high system 

reliability) 
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10.4 Radio coverage survey 

Eltek have provided an online tutorial which illustrates how to perform a radio 
coverage survey. Please visit www.eltekdatareceivers.co.uk/surveytutorial. 
Overview 

Typically a system will consist of transmitters distributed across various floors 
and rooms of a building reporting to an RC250 receiver. Range can be 
extended by means of repeaters that provide both tandem and/or radial 
coverage patterns. 
Systems can be linked by repeater links, enabling communications across 
roadways or car parks. 
Use of an external antenna on the receiver, repeater or individual transmitters 
can be used to optimise range. 
 
Locating the Receiver 

Before the location of the transmitters and repeaters can be considered, it is 
very important to find a suitable location for the RC250 Receiver in the site. 
Care should be exercised in positioning the RC250 Receiver.  
 
Try to site the Receiver at least 5 metres away from the PC so that interference 
is minimised:  
 

>5m

 
 
If the Receiver is connected directly to the PC, an RS232 extension lead may be 
required (RS232/5M for 5m). Alternatively, use an external antenna on the 
Receiver if installation permits: 
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>5m

 
 
The Receiver should also be located clear of all other sources of radio 
interference. 
The following locations/materials will inhibit the performance of the system: 

- Reinforced concrete 
- Metal cladding 
- Rooms that are constructed as Faraday cages 
- Moving machinery that changes position e.g. fork lift trucks, cranes 

10.4.1 Using an RP250GD/RP250GDS to detect interference 

Disconnect the antenna, and if no interference is present the RSSI bar on the 
unit's display should show 2 chevrons or less: 
 

 
 
RP250GDS Only: Switch the audio toggle switch on (located on the top of 
the unit). You should hear white noise only. 
 
Connect the antenna, and if no interference is present the RSSI bar should 
display at most 6 chevrons: 
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RP250GDS Only: The audio should remain as white noise. 
 
If the signal is higher, this indicates that interference may be present. 
Interference can be generated by nearby electronic equipment. If the 
interference is from a nearby telemetry system then an alternative frequency 
for the final installation may be necessary. 
 
Should interference be detected and the origin cannot be found then 
advanced interference detection equipment will have to be used, e.g a radio 
frequency spectrum analyser. Refer to Eltek. 
 
Before installation a survey should be conducted. 

 

10.5 Preparing the transmitter and repeater for the survey 

10.5.1 Prepare the transmitter 

Set the transmitter's transmit interval to 1 second: 
- Connect the survey transmitter to the PC with the cable supplied. 
- In RxConfig, open Transmitter Setup 
- Enter the correct COM port and click OK / Connect. 
- Enter 1 second as the Tx Interval and click Set Tx Interval. 

10.5.2 Prepare the repeater 

- Ensure the battery in the RP250GD/RP250GDS is fully charged. From 
fully drained, the battery takes 3-4 days to charge. 

- Power on the repeater by briefly connecting the mains supply or by 
using the concealed button on the back. 

- When a valid transmitter signal is received by the 
RP250GD/RP250GDS repeater, the transmitter serial number and RSSI 
(signal strength) will be displayed on the repeater's LCD display. 

- If using an RP250GDS, the loudspeaker audio will be change from 
white noise to a short bark or croak. If the signal is strong the bark is 
clean and as the signal weakens the bark will become dominated by 
the white noise. 

10.6 Carrying out the survey 

- Create an initial site map/plan with the prospective transmitter 
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positions located on it. 
- Position the transmitter at the proposed Receiver location. 
- Take the RP250GD/RP250GDS to the first proposed transmitter 

location. 
- View the transmitter's serial number on the RP250GD/RP250GDS 

display.  
- Check the signal strength is greater than 6 chevrons. 
- If the strength is good, mark the survey map with a tick. 
- Continue checking, ticking transmitters when the signal is good. 
- Where the strength is not good, a repeater may be needed. 
- Find an appropriate location for a repeater, both in terms of signal 

transmission and daily operation. 
- Move the survey transmitter to the proposed repeater location. 
- Check the remaining transmitter locations with the 

RP250GD/RP250GDS. 
- Mark the location of the repeater and tick off transmitter locations 

when surveyed. 
At the end of the survey you should have sufficient information to update the 
plan. There may be an opportunity to rationalise the plan (and perhaps reduce 
the number of repeaters) by possibly relocating repeaters. If this is the case the 
survey must be repeated to assure performance. 
 

What can you expect in terms of range? 

Our experience indicates communication across two floors (wood or 
reinforced concrete – and vertically inline separated) will be reliable. 
 
On the same floor expect more than 100m if simple prefabricated walling is 
used, more if the floor is open, and considerably less if steel or panelling of 
mesh lined chambers is present. 
 
Expect 500m for a repeater located in a window which is revealed to another 
repeater in a similar location. 
 
Always configure the repeater to pass the transmitter signal of those required 
and inhibit those not required. This reduces on-air activity leading to best 
system reliability. 
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11. Using the RxConfig software 

11.1 RxConfig System Requirements 

• PC running Windows Vista/7/8/10 

• CDROM drive (for installation) 
• 16Mb RAM 

• 8Mb free hard disk space for program 
• Additional hard disk space for data 

• VGA (or better) display 
• One unused serial port (or USB slot if used with a USB to Serial 

Converter) 

• LC68 cable 
• Eltek RC250  

 
Load the program on your PC – it will try to find an existing Eltek folder. To 
program the RC250 use the LC68 lead. Connect one end to the serial port of 
the PC and the other to the mini DIN socket situated on the top panel of the 
RC250. Set the Com port using File > Properties. 
 
Menu: 
File Load Receiver Upload an existing RC250 configuration 
File  Save Receiver Save the current RC250 configuration 
File  Properties Select PC serial port for communications 

with RC250 and Transmitter 
Tools Turn Receiver off Turns receiver off (display indicated OFF) 
Tools ModBus Setup Sets device (node) address and register 

addresses for ModBus communications.  
See ModBus Configuration section. 

Buttons: in the TX configuration table 

Get TX  Get the current configuration from the 
Transmitter 

Set  Interval  Set TX Interval (use the drop down menu) 
Set Sensor On 
Time 

 Applicable only to transmitter where the 
external sensor needs power before a 
reading can be taken. E.g. GS42/GS44 
and GD43 

Buttons: in the RX configuration table 

Get RX  Get the current configuration from the 
RC250 

Set RX  Set the configuration in the RC250 
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Start Meter / 
Stop Meter 

 Load table with received data 

Edit Chan  Click over a channel, click Edit Channel to 
edit. (Use to accept a transmitter not 
available for direct connection.) 

Clear Chan 
data 

 Click over a channel, click Clear Channel 
data 

Set Nbr 
Chans 

 Enter Number of channels to display (160 
maximum) and click Set Nbr Chans to 
confirm (this reduces unnecessary on 
screen information and speeds up the 
interface). 

11.2 Channel Set-up Procedure 

Transmitter present: 

• Start up the Configuration program. (If this is the first time it has run 
you will need to configure the serial port(s) using File > Properties.)  

• Connect the PC to the RC250 using the LC68 programming lead (and 
USB converter if required) 

• Get the current or start a new RC250 Configuration using the Get RX 
button ( you should see the details appear in the right hand list box). 

• 1Now connect each transmitter to the PC using an LC-TX3* 
programming lead. 

• Use File > Properties to set the TX serial port. 

• Get the transmitter details using the Get TX button (the TX serial 
number will appear) 

• Set the transmitter interval. This should be about one sixth of the 
update interval required in the PC (or connected monitoring device) 

• Click on a channel, click Select Range, and choose input type from 
drop down. Click OK to confirm. 

• Repeat for channels applicable to connected TX 
• Repeat if a number of transmitters are being added to the RC250 

• Connect the PC to the RC250 using the LC68 programming lead 
• Select the destination RC250 channel (by single clicking and 

highlighting it) 

• Select the required transmitter channel (by single clicking and 
highlighting it). 

• Copy the channel details to the RC250 configuration using the >> 
button. Note RxConfig will assume the next TX channel and next RX 
channel are to be linked. Click the >> button to confirm or set up as 
required. To set up another TX, go back to the 1Now connect… step. 
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• Copy the configuration to the RC250 using the Set RX Button. 
 
* To gain access to the transmitter programming socket the bottom cover 
must be removed (2 x pozi-drive screws). Carefully remove the battery pack 
but do not disconnect it. The programming socket is a 3mm stereo jack 
socket that will now be accessible. 

11.3 Columns in the RX Configuration panel table: 

Chan RC250 channel (maximum 160 channels) 
Tx Serial Tx serial number  
Tx Chan  TX channel (alpha character A to H) 
Tx Range TX channel range e.g. Humidity SHT if the B channel of a GD10 

(see Page 9 for an example of the Edit Rx Channel pane) 
Value Tx value of the last valid data received expressed in units 

allocated to the range. These can be default or configured as 
engineering units. 

Batt Tx battery condition expressed in % 
Age  Time, in seconds, since the last valid reading received. Age will 

not be normally greater than 2 times the transmission interval. If 
it is, there may be permanent or temporary loss of 
communications and should be investigated. 

Nbr TX Number of successful transmissions received, indicates the 
reliability of performance and is for comparison purposes only. 

11.3.1 No Data Interval 

Within the Edit RX Channel window is the feature No data Interval. 
The RC250 expects new channel information from the transmitter on a 
frequent basis to refresh the last valid value held in a buffer. If data is not 
received within a configurable period, e.g. due to transmitter failure, the value 
is reported as No Data. This in turn can be processed as appropriate to the 
application by the connected software.  
The No data Interval will default to the TX interval x 6 and can be set (as 
hh.mm.ss) for special applications on a per channel basis. 

11.4 ModBus configuration 

The ModBus Setup menu (Tools - Modbus setup) allows the user to configure 
the ModBus device address and the holding register addresses for the various 
parameters. Node Address should be set to the required slave device ident. 
The following six boxes are for specifying the start address of holding registers 
for reporting the transmitter information. The value in each of these boxes 
must be greater than that in the previous box. The difference must be greater 
than the number of channels configured in the RC250. 
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Description

ModBus slave device ID

Base address of holding registers for the raw values 

Base address of holding registers for the range-scaled values 

Base address of holding registers for the scaling factors

Base address of holding registers for the transmitter battery levels

Base address of holding registers containing the transmitter counter

Base address of holding registers containing the ages of each value.

When reading the values from the RC250, the only Function Code that can be 
used is 'Read Holding Registers' (0x03). It is possible to read several registers at 
a time using the Quantity of Registers field, but note that RC250 is limited to 
50 registers at a time. 
 
NB. The address values used in the RC250 protocol are the actual addresses 
encoded in the Modbus message. Some host communication software 
requires ModBus  Holding Registers in the form 4xxxx or 3xxxx. With this 
scheme, what is referred to as 'Holding Register 40001' is actually addressed 
within the message protocol as register address 0000 (not 0001 or 40001). It 
is very important to ascertain exactly what convention the host software uses. 
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11.4.1 Communications 

Example request to retrieve holding register 100 (set up to contain the raw 
value from channel 1) from node address 6: 
Slave Address 06 
Function 03 
Starting Address Hi 00 
Starting Address Lo 64 
No. of Registers Hi 00 
No. of Registers Lo 01 
CRC Hi c4 
CRC Lo 62 
 
Response from RC250: 
Slave Address 06 
Function 03 
Byte count  02 
Raw Value Hi 06 
Raw Value Lo 2b (in decimal, 1579) 
CRC Hi 4e 
CRC Lo 3b 
 
Example request to retrieve holding register 200-201 (set up to contain the 
scaled values from channels 1 and 2) from node address 6: 
Slave Address 06 
Function 03 
Starting Address Hi 00 
Starting Address Lo c8 
No. of Registers Hi 00 
No. of Registers Lo 02 
 
Response from RC250: 
Slave Address 06 
Function 03 
Byte count  04 (2 readings, so 4 bytes) 
Raw Value Hi 00 
Raw Value Lo e6 (in decimal, 230 - meaning 23.0 degrees) 
Raw Value Hi 01 
Raw Value Lo ed (in decimal, 493 - meaning 49.3 %RH) 
CRC Hi ac 
CRC Lo d9 
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Raw Reg holding registers, other than pulse counts, contain values less than 
65000. Numbers starting from 65441 (0xFFA1) are used to represent out of 
range or fault conditions. These numbers are: 
 65441 (0xFFA1) - Raw value is above maximum value of range 
 65442 (0xFFA2) - Raw value is below minimum value of range 
 65444 (0xFFA4) - Sensor is open circuit 
 65531 (0xFFFB) - No Data 
 65532 (0xFFFC) - Dummy 
 
Scaling Reg holding registers use the scaling factor to represent these same 
conditions. The scaling factor would normally contain a value of 0 to 4. Values 
from 240 (0xF0) upwards contain the following error conditions: 
 240 (0xF0) - Scaled value is above the maximum value of range 
 241 (0xF1) - Scaled value is below the minimum value of range 
 242 (0xF2) - Sensor is open circuit 
 243 (0xF3) - No Data 
 244 (0xF4) – Dummy 

11.4.2 Extra information on RC250 ModBus setup 

The following parameters can be read from the RC250 for each channel: 
 
 Raw value unsigned integer data received by the RC250 from the 

transmitter 
Scaled value signed integer   scaled value from the sensor 
Scaling factor  unsigned integer number of decimal points in the Scaled 

value 
Battery value  unsigned integer percentage transmitter battery level  (0-

100%) 
Nbr Tx unsigned integer Tx count 
 
Conversion from the Raw value to the scaled value uses the following formula: 
Scaled value = (Raw * Span / Max Val + Min)*10^Dp 
Scaling factor = Dp 
The Min, Span, Max Val and Dp can be found by selecting the appropriate 
channel in the Rx Configuration table and selecting Edit Channel. 
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The Edit RX Channel window is shown below: 

 

11.4.3 Serial Data 

Both ModBus and RC250 Serial Interface protocols are implemented on an 
RS232 interface. The interface requires no configuration and will automatically 
respond appropriately to either protocol. It is preset to these settings: 

Baud Rate 19200 
Data Bits 8 
Stop Bits 1 
Parity None 

   

11.4.4 Calibrating transmitter channels using RxConfig 

Documentation detailing how to calibrate a transmitter from within RxConfig 
can be found in RxConfig’s online help. Launch RxConfig, click Help > 
Contents and choose Reference > Transmitter Setup > Calibrating 

Transmitter channels.   

11.5 Help file issues 

Microsoft do not include the Windows help system with Windows Vista/7/8 
/10by default. RxConfig and RpConfig currently use this form of help. You can 
install the help system via Microsoft from the following location(s): 

Windows Vista/7/8:  
https://support.microsoft.com/en-us/kb/917607 

There is currently no way of viewing Windows help files (.hlp) within Windows 
10. 
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12. Transmitter connections 

The following transmitter type suffixes are used to indicate: 

• E – Eltek RHT10E RH/temperature probe (digital interface) (except 
GS42/44) 

12.1 GS/GD13E 

1 x External RH / temperature digital interface
E for RHT10D
J for E plus E EE08

 

12.2 GS/GD14E 

As GS/GD13 but with 2 x external thermistor 
temperature inputs

 

12.3 GS/GD 31/2/4/4R/8 

All inputs for thermistor temperature probes

 

12.4 GD40A 

Inputs A - D

12VDC

: Observe sensor polarity. 

: Connect MP12U5WA external supply if required.

Each input is relay 
isolated. CTs share a common ground.
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12.5 GS41A 

Use with a pyranometer:

Connect green wire to “v”, connect red and blue wires to “-”
SKS1110

CMP3

Connect red wire to “v”, connect black(screen) and blue wires to “-”

The GS-41A can be powered from an external 
9VDC (+/- 0.1V) supply or supplementary battery 
pack (type SP1118) and / or internal batteries. 
External power is connected to “+” and  “0”.

Not in use  

12.6 GS42/42E 

Both transmitters provide two voltage/current inputs, A and B.
 is a voltage input. (0-100mV / 1V / 10V plus EU scaling configured using 

Darca software) 
 is a current input. (0-20mA or 4-20mA plus EU scaling configured using 

Darca software)

If current is used link  to . 

v

c

v c - is the -ve voltage or current input.

The  provides a 5V or 12V sensor supply (the 
selected sensor voltage is present only during 
transmission or if the sensor supply is enabled in 
TxSetup). 

  is sensor supply output -ve
  is sensor supply output +ve.

The  has the option to be powered from an 
external 9VDC regulated supply. 

  is external supply -ve 
  is external supply +ve.

GS-42

0

+

GS-42E

0

+
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12.7 GD43E 

GD-43E/J/JA

Channel B
Thermistor temperature input with range 
-50 to +150 °C.
Channels C, D
These channels are the digital signal and power for the RH and temperature 
probe:
Channel C is presented to the logger as the temperature.
Channel D is presented to the logger as the RH.

A C&D

p
w

r

d
a

ta

c
lk

g
n

d

B

V
/C

- +

T
h

Channel A
Version E
Ranges are 0-100mV / 1V / 10V / 0-20mA / 4-20mA
Version JA
Range -15mV to +15mV with scaling. 
Use with Kipp and Zonen NRLite Net radiometer.
NRLite connections: 	

red +Connect  wire to “ ”
	 Connect black(screen) and blue wires to “-”
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12.8 GS44/GS44E/GS44H 

The  provide four inputs, A B C and D. Each is a voltage or current 
input (v c -). 
 is voltage input,  is current input. If current is used, link  to .  is the -ve 

voltage or current input.

There is a  on Connector 1 and a sensor supply output 
or FET switch on Connector 2. 
Connector 1:  is sensor supply output -ve, is sensor supply output +ve 
Connector 2:  is sensor supply output -ve or FET switch,  is sensor supply 
output +ve or FET switch

There is an  on Connector 1 and a sensor supply 
output or FET switch on Connector 2. 
Connector 1:  is external 9VDC -ve,  is external 9VDC +ve 
Connector 2:  is sensor supply output -ve or FET switch,  is sensor supply 
output +ve or FET switch

The  provides four  voltage inputs, A B C and D. 
There is also an external 9VDC supply input on Connector 1 and a sensor 
supply output or FET switch on Connector 2. 
Connector 1:  is external 9VDC -ve,  is external 9VDC +ve                      
Connector 2:  is sensor supply -ve or FET switch, is sensor supply +ve or 
FET switch

GS-44/44E

v c v c -

sensor supply output

0 + 

0 +

external 9VDC supply input

0 +

0 +

GS-44H bipolar single range

0 +

0 + 

GS-44

GS-44E

GS-44H[suffix letter]

Connector

 

12.9 GS44AVE 

AVE indicates an averaged value is used at the 
point of transmission.
Connector 1

  is external 9VDC -ve (e.g MP9U), 
  is external 9VDC +ve 

Connector 2
(   is No connection, is No connection)

 is a voltage input 
 is a current input (with V to C for current range)

0

+

0 + 

v

c

- is the -ve voltage  
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12.10 GS/GD52 

For 2 x 4 wire PT100

 

12.11 GS60 

A B
+-- +--+-- +--

2 x state inputs are provided: A and B.

An open input is transmitted as a “1"
A closed input is transmitted as a “0"

Note: + is common. V open circuit is nominally V batt 
Input impedance is approximately 10Kohm.

 

12.12 GC62 

Input A: s

s o

: 
: Signal  : -ve 

Signal  : -ve o

Input B: 

2 x pulse input transmitter.

Range 6V to 9V DC (regulated).
Power supply is MP9U from Eltek.

External power in

When external power is applied (and if greater than 
the internal battery voltage), the external power is 
used. If external power fails the internal batteries will 
power the transmitter.

 

12.13 GC62EX 

Not used

Input A: s

s o

: 
: Signal  : -ve 

Signal  : -ve o

Input B: 

2 x pulse input transmitter for compliance to 
IGEN (gas connection) requirements
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12.14 GD67 

External supply input (4-9V, nominally 6V). 
(Diode ORed with internal battery.)

For 7 x pulse inputs with external power. Suitable 
power supply is MP9U5W.

  Signal
  -ve 

Inputs

s

o

 

12.15 GD68 

For 8 x pulse inputs.

  Signal
  -ve 

Inputs

s

o

 

12.16 GD72E 

E&F

p
w

r

d
a
ta

c
lk

g
n

d

A-D

p
w

r

d
a
ta

c
lk

g
n

d

LIGHT RH/T

For use with LS50 lux sensor or LS70 lux / UV sensor
and RHT10D RH / temperature probe.

 

12.17 GD90A/900A 

  
 T

-
  
 T

+
G

N
D

G
N

D
  
 R

-
  
 R

+
G

N
D

+
1
2

V

GD90A: For use with 1 x ND350 3 phase energy meter.
GD900A: For use with up to 6 x ND350 3 phase energy 
meters.
Modbus comms.

 

12.18 GD93A 

For use with Landis & Gyr T230 heatmeters. For other 
MBus applications refer to Eltek.
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13. Specifications 

13.1 Common transmitter specification 

RF specification EN300-220 
RF power 10mW 

Environment specification: 
Compliant to EN300-220 -10 to +55ºC 

Actual -30 to +65ºC 
Humidity     100% non condensing 

  
Environmental rating IP40 

Dimensions (footprint) 78 x 41mm 
Battery endurance up to  5 years (interval set to 5 minutes) 

Transmission interval range 
 

(less for GL-70 and GS40 series) 
1 sec to 4 hours 

Indicator (red LED) transmit active/on/off 
Control switch (concealed) test mode / hibernate 

Antenna socket SMA 
 

13.2 Individual transmitter specifications 

 
Models Sensors Range Resolution Accuracy 

GC04/GD
04 

1 x external thermistor temperature -40 to 
+70ºC 

0.1ºC ±0.2ºC (-15 
to +40ºC)    

0.2ºC ±0.4ºC (-29 
to +65ºC)    

0.3ºC ±0.6ºC (-36 
to +70ºC) 

      0.4ºC ±0.8ºC (-40 
to -36ºC) 

GC06/GD
06 

built-in thermistor temperature As GC04 
  

GC10/GD
10 

built-in temperature (digital sensor) -30 to 65ºC 0.1ºC ±0.4ºC (+5 to 
+40ºC)     
±1.0ºC (-20 
to +65ºC)     
±1.5ºC (-
30ºC)  

built-in RH 0-100% 0.1% ±2% (10 to 
90%RH) 

        ±4% (0 to 
100%RH) 

GD11 built-in temperature and RH As GC10     

  external thermistor temperature As GC04     

GD13E external RH (RHT10E) 0-100% 0.1% ±2% (10 to 
90%RH) 
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±4% (0 to 
100%RH)  

external temperature (RHT10E) -40 to 
+120ºC 

0.1ºC ±0.4ºC (+5 to 
+40ºC) 

        ±1.0ºC (-20 
to +80ºC) 

GD14E external RH (RHT10E) As GS13E     

 
external temperature (RHT10E) As GS13E 

  

 
2 x external thermistor temperature As GC04 

  

GS21/GD
21 

1 x external T or K type thermocouple 
temperature 

-200 to 
200ºC 

0.1ºC / 
0.2ºC 

±0.3ºC 

GS24/GD
24 

4 x external T or K type thermocouple 
temperature / state inputs 

   

GD21AL/

GD24AL 

As GD21/GD24 with audible and visual 

alarm. 

   

GD24HV 4 x external T or K type thermocouple 
temperature 

      

GD24H 4 x external K type thermocouple 
temperature 

-200 to 
1200ºC 

0.5ºC ±2.0ºC 

GD24R 4 x external R type thermocouple 
temperature 

-200 to 
2000ºC 

    

GS31/GD
31 

1 x external thermistor temperature -50 to 
150ºC 

0.05ºC (-5 
to +75ºC) 

±0.1ºC (-5 to 
+75ºC) 

GS32/GD
32 

2 x external thermistor temperature 
 

0.1ºC (-25 
to +100ºC) 

±0.2ºC (-25 
to +100ºC) 

GS34/GD
34 

4 x external thermistor temperature / 
state inputs 

 
0.2ºC (-40 
to +125ºC) 

±0.4ºC (-40 
to +125ºC) 

GS38/GD
38 

8 x external thermistor temperature / 
state inputs 

   

GD32AL/
GD34AL 

As GD32 and GD34 with audible and 
visual alert 

   

GS34R 4 x resistance 0-1K   ±4R 

  
0-10K 

 
±10R (1 to 
10K)   

0-100K 
 

±1K (10 to 
50K) 

        ±4K (50 
to100K) 

GS34R10
0 

4 x resistance 0-100R     

GD40A 4 x voltage inputs with averaging for 
NDMeter SXD CTs 

0-6VDC 
only 

    

GS41Acf 1 x external pyranometer (e.g. Skye 
SKS1110 / Kipp & Zonen CMP3)  

0-
1500W/m2 

3.75µV   

 
1 x calculated average value 0-

1500W/m2 

  

  1 x calculated cumulative (Integrated) 
value  

0-65,000 
Wh 

    

GS41AV 1 x external air velocity (EplusE 
EE66/576) rolling average value 

   

 
1 x calculated minimum  

   

 
1 x calculated maximum  

   

 
1 x instantaneous value (last value 
measured) 
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GS42 2 x external voltage or current 0-100mV DC 0.02/0.03mV ±0.06mV 

GS44 4 x external voltage or current 0-1V DC 0.25mV  ±0.5mV 

GS44AVE As GS44 but with averaging function 0-10V DC 2.50mV ±5mV 

  
0-20mA DC ~5uA 20uA 

  
4-20mA DC 0.05% 0.1% 

GD43E 1 x external RH and temperature 
(RHT10E) 

as GS13E     

 
1 x voltage / current as GS42 

  

 
1 x external thermistor temperature as GS31 

  

GD43JScf 1 x external RH and temperature 
(EplusE EE68) 

as GD13J     

 
1 x voltage / current for pyranometer 0-30mV 0.1% ±30uV 

 
1 x external thermistor temperature as GS31 

  

GD47/GW
47 

1 x built-in RH and temperature as GD10     

 
1 x built-in CO2 0-5000ppm 3% ±50ppm  

  1 x built-in 12VDC supply monitor       

GS52/GD
52 

2 x 2 or 4 wire Pt100 temperature -100 to 
200ºC 

0.1ºC ±0.3ºC 

GS52H 2 x 2 or 4 wire Pt100 temperature 0 to 300ºC 0.1ºC ±0.3ºC 

GC60 2 x state indications       

GC60F 2 x state indications for flood sensors 
only 

      

GC60Y As GC60 with mark/space ration of 
event during TX interval 

      

GC62EX 2 x pulse inputs for connection to 
domestic gas meter 

      

GC62/GC
62a 

2 x pulse inputs (/a inverted input)       

GD67 7 x pulse inputs 
   

GD68/GD
68a 

8 x pulse inputs (/a inverted input)       

GL-70 1 x built-in temperature and RH As GC10     

 
1 x visible light 0-4,000 Lux 0.1Lux 

 

  
0-200 KLux 0.01KLux 

 

 
1 x UV light 0-5000 

mW/m² 

  

  
0-10,000 
µW/Lumen 

  

GD72E 1 x external temperature and RH As GD13E     

 
1 x external visible light (LS50 or LS70) As GL-70 

  

  1 x external ultraviolet (LS70 only) As GL-70     
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GD81 1 x built-in barometric pressure 800-
1100mBar  

0.0122mBar
/bit 

+/-1% FSS 

GD84 1 x built-in differential air pressure -250 to 
+250 
Pascal 

0.1 Pa ±3Pascal 

GD90A 1 x RS485 modbus input for 
NDRail350V energy meter 

Up to 12 
values 

    

GD900A As GD90A but can connect to up to 6 
NDRail350V meters 

      

GD93A 1 x MBUS input for 3 x landis and gyr 
T230 heatmeter 

      

TMET 1 x u type thermistor input As GD31     

 
1 x voltage input for use with external 
device e.g. solarimeter  

0-50mV 0.025% 0.1% 

  1 x serial input for connection to Vaisala 
WXT520 or WMT50 
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14. Transmitter product revisions 

GS34 transmitters with a serial number greater than 13316 and GD34 
transmitters with a serial number greater than 13773 will have a ‘state’ range 
option. 
When open circuit the channel will read 1 and for a short circuit it will read 
zero. 
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15. Thermocouple isolation and interference 

issues 

To ensure accurate and reliable performance the following points should be 
understood and taken into consideration: 
 
Galvanic isolation is essential 

When using multiple non insulated thermocouple probes it is essential that full 
galvanic isolation exists between the probes. Failure to do so will create 
reading errors. 
 

Current loops 

When using thermocouple probes connected to a common transmitter which 
is powered from a source other than internal batteries, potential current loops 
can exist causing reading errors. If it is essential that the transmitter is 
powered externally, the AC power supply must be a type which has extremely 
low AC leakage current (such as medical grade types).  
It is preferred that only the Eltek MP12U power supply is used. In case of 
doubt, contact Eltek. 
 

Induced voltage interference 

When using thermocouples with long leads in the presence of electrical 
interference (e.g. welding equipment or heating control systems, especially 
oven furnace control systems) voltages can be induced into the thermocouple 
tip which will lead to reading errors.  
Ensure that thermocouples are not located close to electrical 

interference. 
 
RxConfig will poll the receiver for meter readings at regular intervals (the meter 
refresh time) when the meter window is displayed and the PC is connected to 
the receiver. 
 
 



 45 

16. Pulse count and GenII telemetry 

The pulse count transmitters GC62 and GD67/GD68 employ the same 
measuring and transmission techniques. 
 

Transmitter 

At the transmitter pulses are counted continuously to a maximum of 65,535. 
When 65,535 is reached the counter is reset to zero and starts counting 
again. 
At the time of transmission the value in the counter is transmitted. 
The transmission interval is normally the logging interval / 6. 
 

Receiver 

The last valid value from each transmitter is held by the receiver in a register. 
The device connected to the RC250 must calculate the difference between 
the previous and current values to determine the number of pulses that 
should be used. 
 

If a no–data condition occurs 

Incidence of frequent no-datas (no transmitted data received by the receiver) 
should always be investigated as a matter of urgency as no-datas could be an 
indication of radio coverage issues. 
The period that the receiver can cope with consecutive no-datas and still 
record a valid value when a transmission is eventually received is 65,535 
pulses. The actual period of time is therefore linked to how frequently pulses 
are expected from the measuring sensors. 
For instance, in the case of The PRO1D electricity meter, the device is rated at 
45A max and provides 2000 pulses per KWh. 
A kettle rated at 2,500W/2.5kW will consume (assuming AC voltage is 
240VAC) 10.41A. So if were left boiling for 12 hours it would consume 
2.5kW/12 = 30kWh.  
This equates to 30 x 2000 pulse from the PRO1D = 60,000 pulses, indicating 
that under the conditions of this unlikely example, if a valid transmission were 
received after 12 continuous hours of no-datas the receiver would self-correct 
and there would be no inaccurate values in the receiver’s data. 
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Declaration of Conformity 

Manufacturer 

Eltek Ltd 
Haslingfield 
Cambridge CB23 1LL 
UK 

Description of Equipment 

RC250 Receiver 
 

I confirm that this instrument conforms to the requirements of the EMC 
Directive 89/336/EEC (amended 92/31/EEC) and carries a CE mark indicating 
conformity. 

Applied Standards 

Harmonised European Standard EN50081 part 1 and EN 50082 part1 for 
emission and immunity. 
 
Radio products conform to ETSI EN300220 -1 

 
 
 

 
……………………………………. 
L.G.H. Hatfield 
Managing Director 
Eltek Ltd. 
 
 
Date: ………………………… 

 

 

01/12/2014 

 


